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          The Story:

          The Tale of the Magi

      In ages long past, the mystics of Ac`Rianed realized their powers were dwindling, and the art of 
the Magi was quickly being forgotten.    The life energy of their world, which fueled their magic, was 
slowly drained by some unknown, yet terrible force.    The people of Ac`Rianed were wasting away, 
while the mystics felt powerless to protect them.

      Thus is was that the mystics came together and crafted their rings - a set of artifacts in which they
could store their remaining power.    Each mystic fashioned a set of rings from a distinctive material, 
and whenever two or more of these similar rings were brought together, the power within them could 
be harnessed.    By separating the rings into different patterns and then reassembling them, different 
aspects of that power could be called upon.

      But it was not enough to simply store this power in the rings.    New apprentices had to be trained, 
lest the secret of the rings be forgotten and the world fall into ruin.    Thus was created a special 
training board upon which novice users of the rings could safely practice their assembly.    Only by 
successfully completing this training can the apprentice hope to restore peace to Ac`Rianed, and 
command the Rings of the Magi...

Intro Sequence



        Intro Sequence

      When the program starts, an introduction and story sequence is displayed.    The intro/story 
consists of a number of short scenes, each of which remains on screen for a short while before 
advancing to the next scene.

      You may advance to the next scene more rapidly by pressing a key or clicking a mouse button.    
You may also bypass the intro/story sequence completely by pressing the [Esc] key at any time.

      If you do not want the intro/story sequence displayed when the program starts, use the Show Intro
option on the Preferences dialog.
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        Beginning A Game

      To start a new game, you may either select New from the Game Menu or press the play game 
button on the Graphical Menu.    The play game button will resume your current game if you have 
already started one, or start a new game if one is not yet in progress.

      To load a previously saved game select Open from the Game Menu.

      Once you have either started a new game or opened a previously saved game, you will be taken 
directly to the board selection screen where you may select one of the puzzles and begin playing.



      Selecting A Board

      The board selection screen allows you to choose which particular game board you wish to play (or
edit).    You may play the boards in any order that you desire.    After successfully completing a board, 
the game will automatically select the next board for you when you return to the board selection 
screen; however, you may manually select a different board.

      In the upper left corner of the screen is the board preview display area, on which a miniature 
version of the game board is displayed.    As you select from among the game boards, this display 
will change to reflect the currently selected board.    If you have already solved the currently selected 
board at least once it will be surrounded by a glowing red border.    You may, however, replay a board
that you have previously solved if you wish to attempt to improve your score on that board.

      Your current best score for this particular board is displayed just below the board preview display 
area, as well as your total score for the entire game.

      The number and name of the current board are displayed just to the right of the board preview 
display area.    You may select the next or previous game board within the current difficulty level by 
using the up/down buttons just below the board number display.

      The difficulty level may be changed by pressing one of the buttons located in the lower right 
corner labeled novice, apprentice, journeyman, master and custom.

      Once you have selected the desired board, press the accept button to begin playing.    Or you 
may press the quit button to return to the main menu without playing the board.

      There are 100 boards in total, 25 in each of the first four difficulty levels.    (The shareware version 
contains 12 boards, 3 in each of the first four difficulty levels).    Additionally, you may create your own
custom boards within the custom difficulty level, or play custom boards created by other owners of 
Rings of the Magi:    Grand Master Edition.
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        Objective

      The object of the game is to remove all of the colored rings from the game board.    Once all the 
rings have been removed from a particular board, that puzzle is completed and you may move on to 
the next puzzle.

      Rings are removed from the game board whenever two or more rings of the same color come into
direct contact with one another.    The rings cannot be moved directly, but are affected by arrow 
buttons located throughout the game board.

      Arrow buttons indicate the direction in which they will exert their force.    When an arrow button is 
pressed, all the rings in the indicated row or column will move one step in the indicated direction, 
unless blocked or hidden behind a solid object.

      Ring movement may be blocked by a solid wooden game piece, or by an arrow button, or by 
another ring if that ring is itself blocked by some solid object.    Additionally, a ring may be blocked by 
the edge of the game board itself -- it is not possible to push a ring off the edge of the game board.



        Game Board Layout

      The large playing area at the left of the screen is where the game actually takes place.    Upon this
playing area you will see rings of various colors placed along side the arrow buttons in many different
arrangements.    To move the rings, simply point to the desired arrow button and press the mouse 
button.

      In the upper right is the score display.    The board score is your current score for this board during
this attempt to solve it.    The total score is your total score for all boards that you have solved so far.   
The board name is a descriptive name describing the board you are currently playing -- the board 
name sometimes contains a clue about the challenge that you might face while solving this board.

undo - Pressing the undo button will restore the game board to the state it was in before the most 
recent ring movement.    Only the most recent movement can be undone.    If your score changed 
during the most recent move, it is also restored to its previous value.

solve - Pressing the solve button allows you to view one of the possible solutions for this game 
board.    A bright green outline will surround the solve button while the solution is in progress.    The 
game board will then be restarted and the arrow buttons will be automatically pressed to solve the 
board.    You may interrupt the solution at any time by pressing a mouse button or the [Esc] key.

restart - Pressing the restart button will restore the game board to its original configuration.    Your 
score will also be reset to the value it had when this board was selected.

cancel - Pressing the cancel button allows you to leave this game board without completing the 
puzzle.    A message window will pop up on screen asking if you wish to leave before solving the 
current board.    If you wish to resume play, select no.    If you wish to leave and return to the board 
selection screen, select yes.



              Scoring

      Points are awarded as the rings are matched up and removed from the game board.    Additional 
points are awarded for simultaneously removing several rings with a single movement.    The 
following table is an example of some scoring combinations:

    NUMBER OF RINGS
    MATCHED/REMOVED        SCORE
    ---------------        -----
           2                 40
           3                 90
           4                160
           5                250
           6                360
           .                 .
           .                 .



Recovering From A Bad Move

      It is possible to move a ring or match up several rings in such a way as to make the game board 
impossible to solve.    If this happens you should immediately try "undo"-ing your last move.    If you 
do not undo that move, and continue playing, you may receive a warning message indicating that the
game board cannot be solved.

      This message will only appear if the game board cannot be solved AND the "undo" version of the 
game board also cannot be solved.    This gives you the opportunity to correct the mistake yourself 
before receiving a warning.    The "Early Warning" game option on the Preferences dialog allows you 
to change this behavior.    With the Early Warning option on, you will receive the warning message as
soon as the game board becomes unsolvable.

      If you receive this warning you will be asked if you wish to restart the board.    If you select yes the
board will be reset to its initial state and you may try to solve it again.    If you select no the board will 
remain in its current state and you may continue to play the board as is, although it will not be 
possible to actually solve the puzzle.

      You may also restart the game manually at any time by pressing the restart button.



        Completing A Board

      Upon completion of each game board, one of the Mystics of Ac`Rianed will appear and deliver a 
message regarding your performance.    You may press any key or a mouse button to advance 
through this message more rapidly.

      Upon completion of each complete level of game boards, you will be awarded one of the symbolic
finger rings which indicate the status of a Ring Master.    Once you have collected all four finger rings 
you will have truly earned the title Ring Master, and will receive yet another award.    You may then 
join your fellow magi and command the Rings of the Magi, helping restore peace to the people of 
Ac`Rianed.

      Congratulations!



Hints And Tips

      If you make a mistake, use the undo button right away!    If you keep going without undo-ing your 
mistake you may not be able to solve the board!

      Take a good long look at the board before you begin moving the rings.    Are there any "dead" 
areas into which you should avoid moving the rings?

      Try counting the number of rings of each color to help plan your strategy.    For example, if there 
are five red rings on the board, you'll know that you need to create both a three-ring match and a 
two-ring match.

      Sometimes you may need to delay matching some of the rings in order to set up a situation in 
which you can first match the other rings.    Plan ahead, and don't remove a ring that you think you'll 
need later.

      When pressing an arrow button, always check that you will be moving only the rings that you 
intend to move.    This is especially true with the 4-way arrow button.    Check in all four directions to 
verify that it's safe to press this button.

      If you just can't seem to solve a particular board, try viewing the first portion of the solution by 
pressing the solve button.    Perhaps it will suggest a new strategy to you.

      Often, the first match is the most difficult.    Once the first match has been accomplished the other 
matches are often much easier.    For very difficult boards, try enabling the Partial Solve option, then 
press the solve button.    After the first match, interrupt the solution by pressing a mouse button and 
try to finish the board on your own.

      Have you found the hidden game?    There is a stone frame which surrounds the graphical menu -
try pressing each of the stones in the upper right corner, one of them is a secret button!    Enjoy!



The Menus

    There are two menu systems in Rings of the Magi.    The menu bar at the top of the screen, and the
Graphical Menu.    The menu bar is always visible and contains common commands and options 
which you may need to access at any time during your game.    The Graphical Menu is not available 
while a game is in progress, and presents you with various other commands which you may select 
while not in a game.

Graphical Menu
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    Graphical Menu

        To start a new game, you may either select New from the Game Menu or press the graphical 
play game button.    The play game button will resume your current game if you have already started
one or start a new game if one is not yet in progress.

      The credits button allows you to view the names of those responsible for creating Rings of the 
Magi.

      The editor button allows you access to the custom board editor, where you may create your own 
custom puzzles.

      The instructions button displays a short sequence of brief instructions describing game play and 
the functions of the various screens.    More extensive instructions are available within this help file.

      The high scores button will display the list of players who have achieved the highest scores to 
date.

      The exit button allows you to leave the program.    Note that there are numerous ways to leave 
the program, including this exit button, the Exit menu item on the Game Menu, the Ctrl-X shortcut, 
the system menu at the top left of the window, and the close button at the upper right of the window 
for users of Windows 95.



        Game Menu

      The Game Menu allows you to start a new game, open a previously saved game, save the current
game, quit the current game, resume a suspended game, or exit the program.    Note that not all 
options are available at all times.

New - Starts a new game and takes you immediately to the board selection screen where you may 
select a board and begin playing.

Open - Loads a previously saved game and takes you immediately to the board selection screen 
where you may select a board and begin playing.

Save - Saves your current game.    If you have not previously saved your game you will be prompted 
to enter a filename.    If you have previously saved your game it will be saved immediately as the 
current filename.

Save As - Saves your current game, prompting you for a new filename.

Quit - Leaves the current game and returns to the main menu.    If you are currently in the middle of 
solving a board, you will be prompted for confirmation before leaving the game.

Resume - If you have a game open but are not currently playing it, this option allows you to continue 
playing the current game.    You will be taken immediately to the board selection screen where you 
may select a board and resume playing.

Exit - Exits Rings of the Magi.    You will first be prompted for confirmation.    If you have unsaved 
changes in your game, you will be given the opportunity to save your game before exiting.



        Window Menu

      The Window Menu allows you to change the appearance of the game window. 

Small
Medium
Large
Extra Large - Each of these options selects one of the preferred resolutions for the game and 
centers the game window on the screen.    These particular resolutions offer correct aspect ratio as 
well as performance benefits.    You should choose a resolution based on your Windows display 
resolution, the speed of your computer and your personal preference.

      (The author prefers the Large resolution in most cases - if the computer is fast enough to support 
it.      Note that while these resolutions are preferred, you are always free to manually resize the game
window to any size that you choose, including maximizing it.    These predefined sizes are simply for 
convenience, you are not limited to them.)

Fix Aspect - If you have manually resized the game window, it may not be perfectly "square".    That 
is, it may be either too tall or too wide, thus distorting the images.    Fix aspect will correct this 
problem by adjusting the width and height of the game window so that it is "square" without changing
the total screen area of the game window.



      Options Menu

      The Options Menu allows you to change various game settings and access optional features.

      The Music/Sound menu item allows you to select the type and volume of music and sound within
the game.

      The Preferences menu item allows you to change the speed of the game, as well as enable or 
disable various additional features.

      The Clear High Scores menu item allows you to completely reset the high scores roster.    You 
will be prompted for confirmation before the roster is cleared.

      The Review Awards menu item allows you to see the awards that you've acquired so far.    
Awards are given once you have completed all of the boards within a difficulty level, and when you 
have completed the entire game.    This menu item is only available if you have previously acquired 
at least one award.    It is also not available while a game is in progress.

Music and Sound
Preferences



Music and Sound

      The Music and Sound dialog box allows you to turn music and sound effects on or off, as well as 
adjust their volume and optimize the music for your particular sound card.

Music - The check box allows you to turn the music on or off.    The volume slider allows you to 
adjust the volume of the music.

Sound - The check box allows you to turn the sound effects on or off.    The volume slider allows you 
to adjust the volume of the sound effects.

Optimize Music For - If you have a sound card which uses FM synthesis to generate music, such as
a SoundBlaster or compatible, you may want to select the music which has been optimized for FM 
synthesis sound cards.    If you have a sound card which uses wavetable synthesis to generate 
music, such as the AWE32, you may want to select the music which has been optimized for General 
MIDI.    Simply select the type of music which sounds best in your opinion with your sound card.
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General Options
Show Intro - If this option is ON the introductory story sequence will be shown when the game is 
started.    If this option is OFF the story will be bypassed.    You may also advance through the intro 
more rapidly by pressing a key or mouse button, or you may bypass the entire story manually by 
pressing the [Esc] key at any time during the intro.

Auto-Pause - If this option is ON the game will automatically pause whenever the mouse cursor 
leaves the game area.    This may reduce mouse flicker on some computers.    If this option is OFF 
the game will not automatically pause as the mouse leaves the game area.    (In either case, the 
game will still pause whenever a menu is activated.)

Auto-Solve Speed - This slider controls the speed at which the Auto-Solve feature solves the board. 
Slide the control towards the turtle on the left for slower speeds, or towards the gazelle on the right 
for faster speeds.

Custom Board Prefix - This is the first six letters of the filename used to save and load custom 
boards which you have created with the board editor.    The actual number of the board is appended 
to this prefix to create the final filename.    By default, the prefix is "CUSTOM", thus the boards you 
create will be named CUSTOM01.BRD, CUSTOM02.BRD, etc.

Preferences



Speed Options
      The Speed Options trade quality of animation for speed of game play.    When these options are 
enabled they make the game quicker by reducing the amount of animation associated with some 
particular aspect of the game.

      Also note that if you are having trouble with the speed of the game in general, you may want to 
consider some of the options under the Window Menu, or see the Troubleshooting section.

Fast Menus - If this option is ON, the menu trap-door animation on the Graphical Menu screen is 
reduced.

Fast Preview - If this option is ON, the board preview display flipping animation on the board 
selection screen is reduced.

Fast Popups - If this option is ON, the magi pop-up messages zooming animation on the playing 
board screen is reduced.

Fast Fades - If this option is ON, the animated transitions between screens are reduced.

Fast Rings - If this option is ON, the rings movement animation on the playing board screen is 
reduced.

Preferences



Gameplay Options
Yes/No Prompts - If this option is ON, you will be prompted before certain actions, such as starting a
new game if a game is currently in progress, quitting a game while you are currently attempting to 
solve it, and exiting the program.    If this option is OFF, the requested action will be performed 
without prompting.

Solve Scoring - If this option is ON, you will accumulate points when boards are solved by the Auto-
Solve feature.

Partial Solve - If this option is ON, you will be allowed to interrupt the Auto-Solve feature without 
restarting the game board.    You may then finish solving the board manually.

Manual Pick - If this option is ON, then the next board will not be automatically selected for you after
completion of a board.    You must then select your next board manually.

Early Warning - If this option is ON, you will receive a warning message immediately upon executing
a move which leaves the board in an unsolvable state.    If you choose not to restart the board, then 
be sure you undo your most recent move if you wish to be able to solve this board.    If this option is 
OFF, you will not receive this warning message until even an undo cannot restore the board to a 
solvable state.

Preferences



Extra Options
Fireworks 1 - If this option is ON, additional animation will occur whenever rings are matched and 
removed from the board.    A small number of ring fragments will explode outwards around the 
matched rings.

Fireworks 2 - If this option is ON, additional animation will occur whenever rings are matched and 
removed from the board.    A large number of round ring fragments will explode outwards across the 
entire screen.

 (You may turn on/off either fireworks option individually, or both options simultaneously.)

Silly Voice - If this option is ON, the magi which congratulates you at the end of each successfully 
solved board will develop a sweet tooth, and occasionally respond with a new message.

Magi Text - If this option is ON, the text of the magi's congratulatory speech is displayed on screen.   
(This option is primarily intended for hearing-impaired players, and those without sound cards.)

Preferences



        Help Menu

      The Help menu displays information about Rings of the Magi.

Contents - Activates this online help file.

About ROTM - Displays version and copyright information.



The Editor
      The board editor allows you to create your own game board layouts -- all without any 
programming knowledge required!    Creating new game boards is as simple as using a paint 
program.    Simply "paint" the game board with the desired game pieces, and then play it!    What you 
see is what you get!

      You must first select one of the custom boards that you wish to edit.    For more information on this
process, see Selecting A Board.    Notice that the score windows will contain the word editor to 
indicate that you are in edit mode.    You may only select among the boards within the custom 
difficulty level while in edit mode -- you cannot edit the original game boards that came with Rings of 
the Magi.

Editor Layout
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        Editor Layout

      The large playing area at the left of the screen is where actual editing takes place.    It is on this 
game board grid that you may place the various game pieces in whatever arrangement you desire.

      In the upper right is the current object display.    This indicates which of the game piece objects is 
currently selected for use with the editor.

      Below the current object display is the selection area.    You may select one of the game piece 
objects by pointing to it within this area and pressing a mouse button.

      Below the selection area is the board name entry display.    You may create a distinctive name for 
your board by pointing to the entry window and pressing a mouse button.    A red cursor will appear, 
indicating that you may then type in a name from the keyboard.    Press [Enter], or click the mouse 
outside the entry window    to complete the process.

      The save button writes your new board to a file.    The exact filename is determined by the 
Custom Boards Prefix option on the Preferences dialog.    Make sure you save your edited board if 
you wish to be able to play it later.

      The play button allows you to try out your newly created board in "test" mode and check that the 
board plays how you expected.    While playing in "test" mode, your total score will not be affected.

      The quit button will return you to the board selection screen.

Editing Tasks



        Editing Tasks

      Editing a game board consists of first selecting a game piece, then placing
that game piece on the game board.    The game boards within Rings of the Magi consist of twelve 
distinct game piece objects and areas of blank space.    There are six different colored rings, one 
solid piece, and five arrow buttons.

      These various objects are selected by pointing to the desired object in the selection area and 
pressing a mouse button.    The newly selected game piece will then be displayed as the current 
object and will remain the current object until a new one is selected.

      To place the current object on the game board, simply point to the grid cell where you would like 
to place it and press the left mouse button (LMB).    You may also continue to hold down the mouse 
button and drag the mouse to repeatedly place the object throughout the board.

      An alternative method for selection the current editing object is to use the right mouse button 
(RMB) to point to an object already on the game board and grab it for later use.    You may then place
it with the left mouse button as described above.

      Summary:

    LMB = PUT object  on  game board
    RMB = GET object from game board

Editor Layout



        Solution Recorder

      You may record your own solution "scripts" for each of the custom boards that you create.    Once 
in record mode, the program will remember each of the moves that you perform in order to solve the 
current game board.    When you have finished recording, you may then press the solve button at 
any time to automatically solve your custom boards, just as it works with the original game boards.

      Record mode is activated by pressing Ctrl-R while playing a game board.    A bright red outline will
surround the solve button while recording is in progress.

      You may cancel record mode by pressing Ctrl-R again.    Record mode is also cancelled if you 
press the solve,    restart or cancel buttons.

      You may use the undo button while recording - the move which you undid will not be recorded as 
part of your solution script.



Keyboard Shortcuts
      There are keyboard equivalents for every button displayed on the screen.    Typically the shortcut 
key is the first letter of the button's label.

        For example, the shortcut key for the restart button on the game board screen is "R".    Pressing 
the "R" key will have exactly the same effect as clicking on the restart button with the mouse.

      Additionally, the [Enter] key is often used as an additional keyboard shortcut for buttons which are 
commonly pressed, or which confirm an action.    The [Esc] key is often used for buttons which are 
commonly used to cancel or quit an action.

      For example, the [Enter] key serves as a shortcut for the accept button on the board selection 
screen, while the [Esc] key serves as a shortcut for the quit button.



Troubleshooting
The game plays slowly on my computer:

· Rings of the Magi runs best in 256 color display modes (also known as 8-bit display modes).    If 
you have Windows configured for a different display mode you may wish to try changing your 
display settings.

· You may want to experiment with the various window sizes available under the Window Menu to 
find one which might perform better.

· If you are using Windows 3.x, you can improve performance by installing WinG.    Microsoft 
released WinG as an add-on for Windows 3.x specifically to improve graphics performance, and 
Rings of the Magi will take advantage of it if present.

· If you are running other programs in the background while playing Rings of the Magi, try closing 
them - they may be using up valuable system resources.

· You can speed up several specific aspects of the game by enabling the Speed Options on the 
Preferences dialog.

When I run ROTM with other applications the colors go crazy:

· In 256-color display modes, all running applications must share the same set of 256 colors.    
However, only one application (the active application) has control of the color palette at any one 
time - this may cause inactive applications to look "funny", since they are forced to use the 
"wrong" color palette.    An application should restore its own colors once it is again activated.    If 
you are using 256-color wallpaper it will be similarly affected by the changing color palettes.

I hear no music, or cannot adjust the volume of the music:

· ROTM may be unable to change the volume on some sound cards with older driver software.    
(The SoundBlaster AWE32 is one such card.)    If this happens you will not be able to adjust the 
music volume with the volume slider.    You might not hear music at all if the volume is set low.    
To solve this problem you should acquire and install the latest driver software from your sound 
card manufacturer.    (The SoundBlaster AWE32 will work correctly with ROTM if the latest driver 
software is installed.)
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How To Order Rings Of The Magi
This game is shareware.    You may freely try it.    If you like it or find it useful, then you must register 
with MVP Software.    To "register" a shareware game means to purchase it directly from the 
developer.    (Shareware games are evaluation versions only, which means you have the right to try 
them, but after trying them you must either register them with the author or delete them from your 
system.    It is unlikely that anyone will check up on you, so shareware works because of the honesty 
of users.)    When you register you will receive Rings of the Magi for Windows: Grand Master Edition, 
which includes all of the following additional features:

      * Over 8 times as many puzzles; 100 puzzles in all.
      * Additional graphics; 3 times as much.
      * New animations and awards sequences.
      * Auto-solve feature. Stuck on a hard level? This is what you need!
      * Level editor. Create your own custom puzzles and stump your friends.
      * Bonus features, animations and options.
      * Printed manual full of hints and tips from the author.

To order, call MVP's 24-hour order hotline at 800-968-9684 or 616-831-7985.    Please have your 
Master Card or Visa ready when you call.    Or fill out the order form and fax it to 616-831-7981.    
Make sure your credit card number and expiration date are legible.    Or if you prefer mail the order 
form and your check to:
      MVP Software, P.O. Box 888281, Grand Rapids, MI 49588.

The price is $19.95 plus shipping.    Shipping is $4.00 in the US, $5.00 to Canada, and $6.00 to 
everywhere else.    Michigan residents please add $1.44 sales tax.
    

How to Register Online and Receive
Rings of the Magi for Windows: Grand Master Edition Immediately!

MVP is pleased that Rings of the Magi for Windows: Grand Master Edition can now be registered 
online, with immediate download of the registered version.    This service is available to anyone who 
has access to the World Wide Web and has a Master Card or Visa.    To register Rings of the Magi 
online, set your web browser to http://www.mvpsoft.com.    Once you are connected, go to the 
Station Exchange.    There you may purchase Rings of the Magi for Windows: Grand Master Edition 
and download it immediately.    While you are there check out the other specials in the Station 
Exchange, as well as download any other MVP shareware game you want from our Web Page.



Contacting MVP Software
Mail/Post:

   MVP Software
   P.O. Box 888281
   Grand Rapids, MI 49588-8281
   U.S.A.

Telephone:

   Orders from US and Canada: 800-968-9684 (24 hours)
   Orders from overseas:      616-831-7985 (24 hours)
   Technical Support:         616-831-7981
   Fax:                       616-831-7982

CompuServe:

   GO MVPSOFT

World Wide Web:

   www.mvpsoft.com

For additional information see the ROTM.DOC file.






